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Abstract

In the past years, computer-assisted methods have become more and more accepted in the
fields of orthopaedic surgical treatments. This trend has been encouraged by the needs of
more automated and digitized forms of aids to be used in the operation theater and also to
assist pre-operation planning. Surgeons have long practiced using exhaustive methods
and now seeking other tools to enhance their skills which will hopefully reduce traumas
and produce better post-surgical outcomes.

The emergence of high performance computing and graphics hardware changed the way
medical data were analyzed. The development of virtual medical simulators has allowed
healthcare providers to practice procedures without real dire consequences and establish
skills, standards, and optimizations before actual surgery. An ideal medical simulation
system will integrate the components of visualization, automated model generation,
surgery simulation, and surgery assistance into one system.

This thesis project aims to meet these criterions in developing a system specifically
designed for implant fitting procedures in the human femoral anatomy. Three-
dimensional models acquired from past researches will be manipulated using the
softwares Geomagic Studio Version 5.0 and Rhinoceros 3.0 to build a custom-fitted
implant model, which strives to be beneficial to the surgery procedures, as well as the

parties involved; medical practitioners and patients alike.
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Chapter 1

Introduction to The System

Chapter Outline

This chapter will discuss the general overview of the system which contains problem statement,
objective of the system, project scope and also the project schedule. These will introduce the user

to the system and emphasise on the importance of the system.



1.0 Introduction
Computer-aided surgery procedures are becoming commonplace in today’s world, as trends

toward geometrically precise and minimally invasive surgery accelerate. These trends are driven
by the desire for better clinical results, lowering overall costs through shorter hospital stays,

shorter recovery times, and need for repeated surgery.

Advances in medical imaging technology such as computed tomography (CT) and magnetic
resonance imaging (MRI), combined with the advances in computer-based image processing and
modelling capabilities have given physicians the ability to visualize anatomic structures in live
patients and to use this information to improve diagnosis and treatment planning. A number of
systems have been developed for various forms of neurosurgical procedures, orthopaedics,
opthalmology, craniofacial surgery, and otolaryngology, among others. A common characteristic
of these systems is that they rely on position sensing during the surgical procedure to enhance the
surgeon’s ability to manipulate surgical instruments very precisely and to accurately execute a
plan based on 3D medical images. By combining human judgement with machine precision,
such systems permit a surgeon to perform critical surgical tasks better than an unaided surgeon,

and enable him/her to do other tasks that could not be done at all (R.H. Taylor et al,1996).
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1.1 Problem Statement

(@)

(ii)

(i

(iv)

v)

(vi)

Patients have been exposed to risk of infections, repetitive or even total failure surgeries
using the current trial-and-error approach in orthopaedics. According to Rockwood and
Green’s The Adult Hip (Fourth Edition), surgeons have to do the measuring of the femur
bone on the operation table, and repeatedly try to insert the implants in the hopes to
achieve an exact fit. This method also includes removing some amount of the bone
surface from the front, end and back of the femur if the implant cannot be fitted properly.
The financial cost of an implant insertion procedure and the post-operative treatments
may increase as some patients need to undergo repeat or corrective surgeries.

As financial cost increases, so does the time taken to perform the surgeries and for the
patients to fully recuperate.

The femur possesses a rich vascular supply. Therefore, major blood-loss into the thigh is
present in most cases. 21 out of 53 patients required blood transfusions as the estimated
blood-loss is around 1200 ml. If a surgeon is not cautious when inserting while inserting
the implants, severe damage could occur in the blood vessels and result in delayed
healing or even worse, paralysing the thigh and knee movements (Rockwood et al, 1996).
A present method of simulating femur implant surgery is by using synthetic bones.
Medical students and surgeons conduct trial surgeries by cutting these synthetic bones
and fixing implants on them. This technique is considered useful but, however, proves to
be expensive since the bones are non-reusable and it usually takes hours of practice to
achieve the required skills (O. Sourina and A. Sourin).

Most implants are currently manufactured in European countries, tailored to meet the

physical/anatomical needs of Caucasians. Asians however, have different skeletal
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structures where the lateral groove and lateral epicondyle are curvier compared to
Caucasians’. This phenomenon is contributed by the Asian lifestyle where the people do
a lot of squatting and bending activities in their daily tasks.
With the emergence of advanced technology in computing, it is fair to justify the fact that it is
unnecessary and no longer acceptable to put patients, time, or financial at risk. This can be a
chieved through thorough modelling, studying and understanding all aspects of a problem
regarding an orthopaedic surgery procedure, The US National Aeronautics and Space
Administration (NASA) has found that computer modelling, simulations and virtual reality

techniques would be the solution to hinder such constraints.



1.2

Project Overview
This project will concentrate on the lower extremity of a human femur bone and a curvy
implant called the metal femoral component (to be fitted on the condyle). Past researches
have been based on these specimens whereby 3D models of the femur bone have been

reconstructed using techniques such as Rapid Prototyping from CT and MRI images.

A B
Stage 1 Stage 1
Acquiring of medical images Acquiring of implant model in
(CT, MRI) point cloud form
(Laser scanning, Probing machine)

Stage 2
2D image processing
(segmentation, filtering, etc) Stage 2
Reverse engineering
(Resurfacing, modeling)
Stage 3

3D femur bone model
reconstruction

Final Stage

Image/model rendering
(Simulation of implant fitting)

Figure 1.1 Process of building a Femur Implant Fitting Simulator System
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With reference to figure 1.1, this research is divided into two parts; Part A dedicated to the bone
modeling processes and part B to implant modeling.

e PartA

Stages 1 to 3 has been carried out by past researches, which involved data acquisition to
3D modeling of the femur bone.
e PartB

This is the most integral part of this thesis whereby the physical implant model was

scanned using laser technique and the data has been saved into the point cloud format

(*.asc) in Stage 1. The project will initially start off with applying the reverse engineering

processes on the implant data, to obtain its surface and do the necessary filtering. The

resurfacing process will be carried out using the software Geomagic Studio Version 5.0.
Then, the product from Part B — Stage 2 will be combined with the femur bone model from Part
A - Stage 3 in developing the final stage, which is to custom fit the implant to the individual

features of the bone anatomy. This will be carried on the Rhinoceros 3.0 platform.

The advantage of the system is that not only will it be able to reduce post-operative traumas, but
also allows users to learn through the graphics, and later on practice repeatedly on how to
achieve the best fix for each fracture, without involving a live patient.

Further explanation of this procedure will be included in the system design and implementation

chapter.
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1.3

(ii)

(iif)

(iv)

Project Objectives

To reduce financial and time cost

As discussed in the problem statements section, current method of orthopaedic surgery
imposes the threat of high financial and time cost. With the aide of computer simulation,
the actual procedure would take a minimized required time, hence lessens financial
burden.

To ease work burden

The responsibility of carrying out a perfect surgery is very tedious whereby surgeons
have to measure and cut/drill the femur repeatedly to ensure exact fit of the implant. This
system may contribute to a less tiresome approach.

To produce a system with good quality

The system must be able to demonstrate a consistent and high quality output when
running the simulation. As the specimens for this thesis are limited, a perfect output
would enable further elaborations or upgrading towards various variables and able to be
used on any type of bone size or implant-type.

To produce a system with high accuracy

If the system is able to accurately simulate real-time procedure, the more reliable it is to
be actually implemented in an actual surgery. This is important to avoid traumas and

complications in fitting the implant into the femur bone.

15



1.4

(ii)

(iii)

Project Scope

The simulation will only involve a specific adult human femur bone and one metal
femoral component implant.

The simulation process will combine the tools included in Geomagic 5.0 and Rhinoceros
3.0 as some features are not available in one software as in the other. Therefore, these
softwares will complement one another.

This system will concentrate on the femur condyle and its implant, but not on the

complementing tibial implant which in real situation would work as a unit..
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.5  Project Schedule
The first phase of Simulation of Implant Fitting In The Femur Bone project started in
June 2003. It has been initialised by the problem statements, objectives and scopes
definition which will eventually lead to the system design stage. The details of project
schedule are illustrated in the Gantt chart, figure 1.2 as follows:
09 Jun ‘03 23 Jun ‘03 07 Jul '03 21 003 04 Aug 03 18Ag'03 3
STT M T[S s[T T 18 s
(Eriissisiiez)omaiaseis 1
‘ | ENEE
| | S |
, i Q | ,
O |TaskName - Stant ~ Finish Prodecessors
1 [E] | Planning . 3wks| Mo 1680803 Fri 0407103
2 | Literature and existing systems review,  6wks| Mo 07/07/03 Fri 1506/03 1
3 MethodologyRechniue decision | 2 wks, Mon 18/08/03 Fri 20006/03 |2
4 |F§ | Requrementsdecison | 1wk Min110803  Fri150803
5| | Systemdesign 2wks| Mo 160803  Fri2g0603 4

Figure 1.2 : Gantt Chart of Project Schedule
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Table 1.1 below explains in detail about each activity that has been mentioned in the

Gantt chart.
Activities Subsections
» Problem statement
Planning » Objective definition

Scope and restriction definition

Literature and existing system review

Thesis and paperwork review
Existing system review
Existing system demonstration
Survey on techniques

Methodology / technique

Selecting the best and suitable
technique
Studying the chosen technique

Requirements decision

Draft requirements specification
Draft design specification includes
user input, output, processing
Programming tools survey

System design

Design decision

List of all modules

Define user input and output
Data flow diagram

Table 1.1 : Project activities

18




Chapter 2

Literature Review

Chapter Outline

This chapter reviews the anatomy of a human femur bone and the fracture-types associated with
it: and how reverse engineering, 3D modelling and simulation are correlated. There are also
reviews on some of the current existing systems which are similar to this thesis project, as well
as comparisons between the software that can be used to develop it. This chapter will act as a
guideline on how to develop the actual system based on the existing systems and the specified

specimen.

19



2.1 Femur Bone Anatomy
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Figure 2.1 (a) : Anterior surface of the right femur

Figure 2.1 (b) : Internal Structure of the femur
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The human femur bone is the longest and strongest in the skeleton with a shape that is almost
cylindrical in the greater part of its extent. In the erect posture, it inclines gradually downward
and medial-ward approaching the lower part, for the purpose of bringing the knee-joint near the
line of gravity of the body. The degree of this inclination varies in different persons, and is
greater in the female than in the male, which is contributed by the greater breadth of the pelvis in

the former. The femur is divided into three part, a body and two extremities :

OMwrater istermns and Gemelli
Piriformis
!

Toawrtion of Obtwrator
Crternve

v = Oresier ton banger

Figure 2.2 : Upper extremity of right femur viewed from behind and above

* The upper extremity (proximal extremity, Figure 2.2)

Presents for examination a head, a neck, a greater and a lesser trochanter

1) The head (caput femoris)
Globular in shape, is directed upward, medialward, and a little forward, the
greater part of its convexity being above and in front. Its surface is smooth, coated
with cartilage in the fresh state which gives attachment to the ligamentum teres.

i) The neck (collum femoris)
Connects the head with the body, and forming a wide angle opening medialward

with the latter. In an adult, the neck forms an angle of about 125° with the body,
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but this may vary in inverse proportion to the development of the pelvis and
stature. There is also a difference in the formation between a male and female. In
a female, it forms more nearly a right angle with the body than it does in a male.
The neck has two surfaces, anterior and posterior, and two borders, superior and
inferior.

iii) The trochanters

These are the prominent processes which afford leverage to the muscles that
rotate the thigh on its axis. They are categorized into the greater and lesser
trochanters :
» The greater trochanter
Large, irregular, quadrilateral eminence. It is situated at the junction of the
neck with the upper part of the body. It has two surfaces (lateral and medial)
and four borders (superior, inferior, anterior, and posterior)
» The lesser trochanter
A conical eminence, which varies in size in different subjects. It projects from
the lower and back part of the base of the neck. The borders are classified as
medial, lateral and inferior.
The body or shaft (corpus femoris)
The body is almost cylindrical in form, a little broader above than in the centre, as well as
broadest and flattened from before backward below. Three borders are present to separate

three surfaces which are the posterior (linea aspera), medial and lateral.
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Figure 2.3 : Lower extremity of right femur viewed from below

The lower extremity (distal extremity, Figure 2.3)

This region of the femur bone is larger than its upper extremity. It is almost cuboid in
form, and consists of two oblong eminences known as the condyles.

(Henry Gray, 1918)
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2.2 Fractures of the Femur

Femoral fractures in human

Shaft Distal
(Supracondylar and Intercondylar)

Proximal Midshaft Extra - Intra -
Third articular articular

: . Isolated
Distal Third Condylar

Figure 2.4 : Types of fractures in the femur bone

According to figure 2.4, fractures in the human femur bone can be primarily classified into two
categories, shaft and distal. Fractures in the femur shaft are mainly created by violent forces
(comminution). This may lead to life-threatening instances such as open wound, fat embolism,
adult respiratory distress syndrome or resultant multiple organ failure. Other major physical
impairment could also arise, though not functional loss (as the femur is the strongest human bone
and possesses a well-vascularized , thick envelope of muscles that promote rapid fracture
healing).

Distal/supracondylar fractures are thought to be caused by axial loading with varus/valgus or

rotational forces. In younger patients, the injury typically occurs after high-energy trauma related
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to motor vehicle accidents. In the case of older patients, fractures frequently occur after a minor

slip and fall on a flexed knee, and worsen with conditions of arthritic or osteoporotic bone.

For this project, I will focus mainly on the fractures of the condylar (knee).

Fractures of the knee are subdivided into three major categories, extra-articular, intra-

articular and isolated condylar. Factors that influence the fractures include:

2.2.1

iii)

Degree of displacement

Direction of displacement

Amount of displacement

Degree and amount of comminution
Extent of soft tissue injury
Associated neurovascular injuries
Magnitude of the joint involvement
Degree of osteoporosis

Presence of multiple trauma

Mechanisms of Injury Which Lead to Fractions

High-energy injuries such as motor vehicle accidents, auto-pedestrian accidents, falls

from heights and gunshot wounds.

Lesser degrees of trauma but can still fracture a femur with pathologic bone.

Fatigue failure

A rare cause, located in the proximal or midshaft areas. Mainly occurs in military recruits

undergoing a marked and prolonged increase in physical activities.
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1v) Physical fitness, such as running (accounts for most fractures), triathlon events and
aerobic dancing.

(Rockwood et al, 1996)

2.2.2 Preferred Operative Treatment of the Knee

Comminution is a sign of a high-energy injury. The fractures are associated with a greater blood-
loss into the thigh with open-fracture wounds and may lead to systemic complications such as fat
embolism (Rockwood et al,1996).

The goals of operative treatment of supracondylar femoral fractures are anatomical alignment,
stable internal fixation, rapid mobilization, and early functional rehabilitation of the knee.
Internal fixation of these injuries is difficult. Fixation unquestionably produces the greatest
chance for an excellent result, but complications after its use can also produce the poorest results.
Incorrectly performed osteosynthesis is almost always worse than nonoperative treatment.

The operative techniques are complex, and it is essential to have complete sets of instruments
and implants available, as well as experienced surgical, nursing, and physiotherapy staff. If these

criteria are met, there are several strong indications for operative treatment:

e Displaced intra-articular fractures

e Patients with multiple injuries (to permit early mobilization)

e Most open fractures
e Associated vascular injuries requiring repair

o Severe ipsilateral limb injuries (ie, patellar fractures, tibial plateau fractures)
e Major associated knee ligament injuries

e Irreducible fractures

26



e Pathologic fractures
Relative indications for internal fixation include the following:
e Displaced extra-articular supracondylar femoral fractures
e Marked obesity
e Advanced age

e Fracture around a total-knee replacement

Contraindications to fracture fixation include:

e Active infection

e Severely contaminated open fractures (type I1IB) (acutely)

e Massive comminution or bone loss

e Severe osteopenia

e Patients with unstable multiple injuries

e Inadequate facilities

e Inexperienced surgeons
In isolated closed, displaced supracondylar fractures that require surgery, internal fixation should
be performed within the first 48 hours. If surgery is delayed for more than 8 hours, the patient
should be placed in tibial pin traction. 20 to 30 Ibs of traction is required to reduce supracondylar

fractures in adults. Once length and alignment are restored, this weight can be decreased.

2.2.3 The Knee Implant

The knee is considered as a hinge joint because of its ability to bend and straighten like a hinged
door. However, it is much more complex in reality because the surfaces actually roll and glide as

the knee bends. The first implant designs used the hinge concept and literally included a
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connecting hinge between the components, but newer ones have recognized the complexity of

the joint and attempt to replicate more complicated motions and to take advantage of the

posterior cruciate ligament and collateral ligaments for support.

The implant components are divided into three:

i)

iii)

femoral component

This metal part curves around the interior of the thighbone and has an interior groove
so the kneecap can move up and down smoothly against the bone as the knee bends
and straightens. Some posterior stabilized designs have an internal post with a
circular-shaped device (cam) that works with a corresponding tibial component to
help prevent the thighbone from sliding forward too far on the shinbone when the
knee is bent.

tibial component

A flat metal platform with a polyethylene cushion.

patellar component

A dome-shaped piece of polyethylene that duplicates the shape of the kneecap

anchored to a flat metal plate.

The selection of implant for a particular surgery depends on factors such as the patient’s age,

weight, activity level and health.

The construction of the implant must be taken into account. The metal parts are usually made of

titanium or chobalt/cromium-based alloys and the plastic parts are made of ultra-high-density
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polyethylene. All together, the components weigh between 15 and 20 ounces. However, its
materials must meet criteria such as:
® Biocompatible; can function in the body without creating a local or systemic rejection
response.
® Their mechanical properties must be strong enough to take weight bearing loads and
flexible enough to bear stress without breaking. (Materials recommended are such as
titanium, cobalt/chromium-based alloys, and ultra high-density polyethylene.)
* They must be able to retain their strength and shape for a long time. (American Academy

of Orthopaedic Surgeons, 2001)

Metal
femoral
/~ "»._component

Figure 2. 5: Femoral component
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Metal tibial
component

Figure 2.6: Tibial Component

Polyethylene insert

e

.

Figure 2.7: Polyethylene cushion insert

Patella
component |

Figure 2.8: Patella component
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Total Knee Replacement

Step b

The tibia, with its
new polyethylene
surface, and the
femur, with its new
metal component,
are put together to
form a new knee
joint,

Figure 2.9: Implant fixation of the knee
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The main focus of this project as stated in the introduction section is building a system which
does the simulation of implant fitting in the femur. However, the process of simulation is not

feasible without initially going through the process of modelling in 3D.

2.3 A Brief Overview of 3D Modelling and Its Relation to Medical Operation Planning

Current advances in computer and imaging technologies have made it possible to generate 3D
reconstructed images in a short period of time, using routine clinical radiological data (Images
acquired from CT scans or MRI are usually used as a foundation for constructing a 3D model in
assisting a medical surgery procedure). Each image is then pre-processed to reduce noise,
followed by the process of segmentation and finally, surface reconstruction to convert the 2D
image slices into a 3D surface model. Even before the technology of virtual simulation emerged,
these 3D models themselves have been found to be tremendously helpful prior to carrying out a
medical surgery. The advantages of 3D modelling (especially in surgery planning) can be

described as follows:

= Multiple views, detail views, and cut away views can be easily generated from the model
(Griffins, 1996).

Models can be used in animations, rapid prototyping, Computer Integrated Manufacture
(CIM), or run through any number of design optimization applications (Griffins, 1996).
3D modelling allows experimentation with perspective, flare, viewing angle, and lighting
to achieve the maximum visual impression (Griffins, 1996).

Allows textures to be mapped to the surfaces of 3D objects providing a further level of

realism very difficult to achieve through illustration (Griffins, 1996).
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3D reconstruction allows the visualization and deciphering of complex anatomical

organizations that cannot be perceived on 2D images (Banzeres et al, 2002).

It offers new possibilities for diagnostics and preoperative planning, hence encouraging

the manufacturing of individual implants (Babisch et a/, 1998).

The newer technologies in 3D image visualization seem to solve the problems of the

conventional X-ray technology caused by inexactly-defined magnification factor and

bone morphology(Babisch et al, 1998).

These models open up new findings partly already used in practice (Babisch et al, 1998).

2D

3D

Advantages

Simple routine diagnostics
(taking radiographs in 2D)
Simple data analysis
Simple comparisons /
quality control on the
postoperative radiograph
More favourable cost-
benefit relation

Precise description of
anatomical structures
Precise determination of
implant size

Analysis of joint
movement 1§ possible
Coupling to navigation or
operation robot

Disadvantages

Missing spatial
description of the
anatomical structures
Determination of implant
size only with standard X-
ray technology

To date no coupling to
navigation or operation
robot

More complicated
diagnostics (primary taking
radiographs, secondary
CT/MRT)

More complicated CT data
analysis (time
consumption)

No routine comparison of
3D planning and operation
result (postoperative CT no
routine)

Table 2.1 : Comparison between 2D operation planning (Babisch et al, 1998)
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Figure 2.10 : Comparison of 2D planning (a), with 3D planning (b) with optimal

joint reconstruction (Babisch ef al, 1998)
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2.4  Reverse Engineering
Reverse engineering refers to the process of reconstructing 3D NURBS surface models from
basic point and polyline input data. Although many manufactured objects are now defined on the
computer using some type of 3D modelling software, those outside of the company that
manufactured the part may not be able to obtain the existing geometry on the computer. The
geometry might be needed for product repair or some other purpose such as constructing an
over-sized sculpture of a car,
There are three steps in the process of reverse engineering;
e Stepl
Using an input device or technique to collect the raw geometry of the object, which is
usually in the form of (x,y,z) points on the object relative to some local coordinate
system.
e Step2
Using a computer program to read the raw point data and to convert it into a usable form.
e Step3
Transfering the results from the reverse engineering software into some 3D modelling or

application software so that the desired action on the geometry can be performed.

2.4.1 Issues That Relate to Reverse Engineering
i) Size of the object to be digitized
This will affect the type of digitizing device used. Some input devices can be

repositioned to be able to handle larger objects but users have to be concerned about
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iii)

the potential loss of accuracy. Related questions are how much space around the
object do you have to work with and what are the environmental conditions?

Level of accuracy

Not much of accuracy should be expected. Although the digitizing device used might
be very accurate, users are only collecting data at discrete points. These disjoint
points must then be curve-fit or surface-fit to create a usable 3D model. The fitting
process is where most of the accuracy errors are introduced ( the accuracy of the input
device may not be the accuracy achieved for the usable computer model).

How the data will be used

If we just want to recreate the basic shape of an object for use in fast-moving,
dynamic simulation, then the accuracy is not critical and we would want the data size
of the final 3D model to be small. If the 3D model is not going to be used for
construction or repair purposes, only the 3D polyhedron form is needed. Otherwise,

the raw data needs to be converted to a different 3D modelling form, such as NURBS

surfaces.

2.4.2 3D Input Devices for Reverse Engineering

i)

Electro-Mechanical Measuring Arms

Consist of multi-jointed mechanical arms with a measuring point (touch probe) where
the fingers would be. The arm is pulled and measuring point tip is positioned on the
object. A button is clicked 1o input the point position of the measurement tip.

Although these devices are very accurate, input can be tedious and the size of the

object is limited by the range of the mechanical arms.
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iii)

Point Triangulation Devices

Relatively low cost or home-made devices that use two separately located measuring
tapes or calibrated wires that are connected to a pointing “wand”. The pointing wand
is extended, pulling the tapes or wires, and placed on the object. This type of device
are often used on objects that are too large for other 3D input devices.

Scanning Devices

Non-contact devices which transmit various types of signals (laser,white light,
radiation, sound waves, etc) to determine distances. They collect an enormous amount
of point data in a semi-random fashion. The point data could be organized in

consecutive cross-sectional cuts or be in a fairly random form called a point cloud of

data.
Photogrammetry
Uses cameras to photograph an object from several directions, then read into the

computer in bit map or raster form. Special software is used to align different raster

photographs and calculate points on the object.

2.4.3 Reverse Engineering Software

Special purpose reverse engineering programs may have many tools for performing general 3D
shape manipulation, but their main focus is on the process of converting raw point data from the
input devices into a more usable polygon or NURB surface representation with the least loss of
accuracy. The final 3D computer model does not pass exactly through all of the raw input data

points. This may happen for a polygon model, but the raw data rarely ever matches the exact
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needs of a NURB surface model and the accuracy is less. The processes that occur in an RE

software are as follows:

i) Read the raw point data into the program.

i) Clean up the raw data. Extraneous or obviously wrong points are thrown away. We also
might need to eliminate excess points in flat areas of the object.

iii) “Wrap” the cloud of points with 3D, connected polygons. If the point cloud covers
several objects, the user of the software may have to split the point cloud into smaller
sections before using the polygon wrapping capability.

iv)  The object, now covered in polygons, must be skinned or fitted with NURB surfaces.
NURB surfaces have many nice properties, but their major drawback is that they are
rectangular in nature. This does not mean that they cannot be stretched into almost any
shape. It just means that to achieve a good NURB surface fit to an object, the digitized
object needs to be broken into a collection of rectangular-like areas. The more non-
rectangular the areas, the less accurate the fit will be.  Some reverse engineering
programs try to convert the polygon model to a NURB model automatically and some
require user guidance. This is a trade-off; the automatic methods will generate more
NURB surfaces, but the manual methods can be quite tedious.

V) The final step is to output the NURB surfaces in an IGES file format using either type
128 NURB surfaces or type 143 or type 144 trimmed NURB surfaces. These are the

most common formats for transferring NURB surfaces to other programs,

The reverse engineering process can be summarized as follows:
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1) Define the accuracy you need and determine what you want to do with the 3D model
once you get it in the computer.

i1) Select the software that will perform those tasks and determine whether they require only
a polygon model or whether they require a NURB surface definition.

iii)  Tackle the selection of the input device and the reverse engineering software.

Examples of reverse engineering software are Pilot3D, Surfacer, 3DReshaper, Geomagic Studio

and also Rhinoceros.

2.5 Computer Simulation

2.5.1 Definition of Simulation
In the Oxford Advanced Learner’s Dictionary of Current English (5th Edition), the word

simulation is defined as “the deliberate making of certain conditions that could exist in reality, in

order to study them or learn from them”.

2.5.2 Definition of Computer Simulation

Computer simulation is defined as a discipline of designing a model of an actual or theoretical
physical system, executing the model on a digital computer, and analyzing the execution output.
It embodies the principle of “learning by doing”; to learn about the system we must first build a
model of some sort and then operate the model. Computer simulation can also be described as
the electronic equivalent of building artificial objects and dynamically act out roles with them,
and it serves to drive synthetic environments and virtual worlds. There are three subfields of

computer simulations:
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Model design

y

Model execution |« Model analysis

Figure 2.11 : Three subfields of Computer Simulation
A mathematical model must be created first to represent a physical object. Then it is executed in
a computer program, while updating the state and event variables in the mathematical model.

The process of computer simulation can also be described as in Figure 2.16 below:

real real real real object object object object
object object object object data data data data
data structure
I algorithms |

real system ‘:>
model

modeling
! Il

real behavior j simulated behavior

Figure 2.12 : Real System and Computational Model (Pritschow er al, 2000)

40



2.5.3 The Relationship Among Computer Graphics, Virtual Reality and Simulation

Computer ' Virtual
Graphics S Reality

Computer graphics is the computational study of light and its effect on geometric objects. The

focus on graphics is to produce meaningful rendered images of real world or hypothetical
objects. Animation is the use of computer graphics to generate a sequence of frames which
produce the illusion of continuous motion. Virtual reality is primarily focused on immersive
human-computer interaction as found in devices such as head-mounted displays (HMD).
Simulation can be regarded as the “engine” which drives the graphics and virtual reality

technologies, because by simulating you build the infrastructure necessary for other fields.

2.5.4 The Advantages of Simulation

* In cognitive science and artificial life, computer simulation plays a major role in bringing
together scientists from different fields.

* Simulations are not only theories but also virtual experimental laboratories. Once
constructed, it will allow a researcher to observe phenomena under controlled conditions,
to manipulate the conditions and variables that control the phenomena, and to determine
the consequences of these manipulations (Cangelosi & Parisi, 2001).

» [t is a clearer and more practical way of expressing what a theory or a model say. This

makes the theory/model more verifiable, because the execution of a computer program
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can easily identify the problems, inconsistencies, and incompleteness of the theory or
model.

It also permits the discovery of new predictions that can/must be derived from a theory
and the search of new empirical data that can verify these predictions (Cangelosi &
Parisi, 2001).

Computer simulations tend to be quantitative, whereby they are repeatable, varying the
initial conditions and make all sorts of statistical and reliability analysis (Cangelosi &
Parisi, 2001).

It re-creates reality.

A uniform model of execution technique can be used to solve a large variety of systems.
Simulation may contribute to avoiding errors and waste of resources.

Attempts of construction of a scene can be simulated with the computer and viewed from
points that may be practically impossible to view in reality.

[t contributes to an enormous saving of physical and economic resources.

Interactions are automatically realistic (John Cohen, 2000).

Large dynamic environments are possible (John Cohen, 2000).

Systems with complex interrelationships are possible (John Cohen, 2000).

Simulated experimentation accelerates and replaces effectively the “wait and see”
anxieties in discovering new insight and explanations of future behaviour of the real

system.

The availability of visual modelling and simulation enables decision makers to boost their

dynamic decision by rehearsing strategy to avoid hidden pitfalls.

Errors can be detected earlier on, and this can lead to the reduction of repair costs.
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2.5.5

The use of animation in a simulation process is very useful for model debugging,

validation and verification.

The Limitations of Computer Simulation

Simplication

Artbitrariness of assumptions and details (Cangelosi & Parisi, 2001).

Difficult external validation (Cangelosi & Parisi, 2001).

The calculations involved in renderings take a very long time even on a fast computer. It
can be particularly problematic when facing tight deadlines or when the renderings
produce unexpected results.

It is difficult to predict outcome based on initial conditions, and to achieve particular

behaviours or events (John Cohen, 2000).
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2.6 Review of Existing Systems

2.6.1 The Virtual Bone-setter (VB) (Sourin et al, 2000)
The research for this system was developed for Department of Orthopaedics of Singapore
General Hospital, by the School of Applied Science at Nanyang Technological University in the
year 2000. It was carried out by Howe Tet Sen (SGH) with the assistance from Alexei Sourin
(Moscow Institute of Physics and Technology) and Olga Sourina (Institute of Computing for
Physics and Technology, Russia) who were attached with NTU at the time.
The main objective of developing the system was to train and improve medical students and
orthopaedic surgeons alike in the internal fixation of bone fractures, as an alternative to the
common training of using synthetic bones. The orthopaedic team in the hospital found that those
synthetic bones were not only cost-ineffective (used bones were not reusable after practice), but
also not geometrically suited to the anatomy of Asian bones. Hence, they decided to come up
with a system capable of running on PCs, available in every medical clinic and home. Their goal
was also to develop it without having to incorporate special VR input devices such as head-
mounted displays or goggles. Other factors that were put into consideration :

» Realistic 3D geometric models with behaviour and constraints

= Real-time simulation including collision detection, sounds, etc.

= Real-time 3D rendering

» VR rendering and input technique based on special hardware devices

The VB system uses a mouse as an input device controlling object relocations and implemented

with Criterion’s Renderware, The software evidently provided the required interactivity with a
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reasonable quality of rendering. It was also able to model in hierarchical coordinate systems and

its support of many VR devices provides a very natural environment for the geometric modeling

in the project.

First, virtual models of the fractured bones were reconstructed from the CT data. Then a
geometric database of common fractures were created. For each fractured bone, its polygonal
mesh and additional geometric information were stored. Other properties that were stored
together in the database include the different types of fixation tools such screws, nails, plates,
wires and the locking bolts (which match each different fracture). The implant database would
then be used in the simulation process of pseudo-physical collision detection. The following
basic procedures is then carried out in a VB post-operative surgery :

= Application of instruments and insertion of the implants with the pseudo-physical

collision detection and audio feedback.

= Viewing the objects through “the image intensifier” (X-ray).

= Rotating and zooming the scene and its objects.

*  Walk through the bone canal.

= Reverse process.

= Setting the light.
The program enables guidance for the surgeon and gives him the ability to make independent
decisions. The fixed virtual scene can be saved at any time and stored in the hierarchical
database for further use.
Below is a step-by-step example for femoral neck fracture fixation with cancellous screws :

1) Guided wire insertion to the appropriate depth, under image intensification.
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vii)

viii)

User chooses “ Insert threaded guide wire”, and defines the place on the bone.

Wire appears on the screen touching the bone at selected point.

User defines the direction by rotating wire and inserting it.

Application of “image intensifier view” for simulating the X-ray image.

Multiple parallel guide wires are placed at various distances from the first wire. User
selects “Place multiple guide wire”, and they will be automatically inserted parallel to
the first one. The result of applying an adjustable parallel wire guide device is then

simulated.

Screw length is measured to enable simulation of the cannulated screw measuring
device.

Screw is inserted. User selects the appropriate length cannulated screw from the
database, locates the wire, and places the screw over the wire. Then, other length
cannulated screws are placed over the respective wires.

Guide wires are removed and discarded.

Figure 2,13 : Real and Virtual Surgical Tools and Implants in VB
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Figure 2.15 : Virtual Femoral Fracture Fixation with an Intra-medullary in VB
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2.6.1.1 The Advantages of the Virtual Bone-setter System

It fixes not only fractures, but also allows the simulating of internal operations for
some bone diseases.

Able to simulate a variety of both common and untypical bone fractures and
fixation techniques.

Enables viewing of objects through “the image intensifier”.

Allows rotating of the scene and objects in the scene.

Walk through the bone canal feature.

Users are able to reverse the process.

Useful to help surgeons plan patient-specific, complex procedures.

Could teach correct procedures to students, before they ever have to cut on
expensive synthetic bones.

Practicing surgeons can improvise skills they already possess and develop new

techniques.

In conclusion, the VB system offers lower risk training for students, fewer risks for patients,

better scenario-based practice, and a minimized cost of training.
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2.6.2 Extract by IBM

The IBM Thomas J. Watson Research Center have developed a computer program, called
Extract, for computing and visualizing the interference-free insertion path of an implant into a
hole from computer-aided design models of their shapes. The program formulates the problem as
a “peg-in-hole” insertion problem for complex, tightly fitting, three-dimensional bodies requiring
small, coupled six-degree-of-freedom motions in a user-specified direction. The program either
finds a successful insertion path or reports the “stuck” configuration, in which case it identifies
the surfaces causing the interference, facilitating the redesign of the implant and the hole shapes.
Extract allows the user to view the insertion of the implant into the canal and the stuck
configurations from different perspectives.

The program is reasonably efficient. In about 30 minutes on a RISC System/6000@ Model 530
workstation, Extract can compute an interference-free insertion trajectory for a tightly fitting
implant and a hole shape described with 10000 facets to an accuracy of 0.01 inch. The program
has been successfully tested on 30 real cases provided by Biomet Inc.

To guarantee that the insertion path is interference-free, the program formulates configuration-
space constraints derived from the implant and hole shapes. These constraints specify the implant
configurations for which the implant surface does not penetrate the hole walls. All configurations
in the insertion path must satisfy the constraints. Configuration-space constraints are reduced to
simpler local configuration-space constraints by observing that, because of the tight fit between
the implant and the hole, the motion of any point on the implant surface is constrained by only a
small portion of the hole surface in its immediate neighbourhood. Local configuration-space
constraints are formulated for each pair of implant-surface point and hole-surface element (i.e.,

small area of the surface). (Taylor et al, 1996)
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Figure 2.16 : Implant insertability analysis using Extract
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2.6.3 The PISA Project on Dental Implant Surgery

The PISA (Personalized Implants and Surgical Aids) project was carried out in collaboration
with the Phillips Medical Systems (in the Netherlands), which focused on the clinical pre-
operative planning for placement of dental implants. It takes the user step by step through the
process of positioning dental impants virtually, and ends with the design of a surgical aid/drill
guide for transfer of the planning results to the patient. It was developed on the EasyVision
clinical workstation, plus with an interface between it and a CAD/CAM oriented environment.
The system aims to increase the time for replacement and hopefully a patient will require fewer

replacements with an achieved perfect positioning/fitting of a dental implant.

(Lobregt et al, 2001)

2.6.3.1 The Process

1) The patient data is derived from a CT scan, bone segmentation is produced, stored in
the database and visualized as 3D renderings.

ii) Implants are selected, and placed in an initial position by a single mouse click. It can
be later manipulated to optimize the position. The optimal position for implants is
determined interactively by placing and repositioning geometric models of implants
with respect to the segmented bone and the nerve canal.

iii)  The various images give direct feedback to the user by showing cross-sections of CT
data and implants, as well as 3D renderings of anatomy with implants.

iv)  When the implants are optimally positioned, an interactive function for generation of

a drill guide can be started.
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V) A user-definable contact area on the bone surface, together with the positioned
implant models, forms the input for an automatic procedure which generates a
complete CAD/CAM-compatible description of a suitable drill guide shape. The
contact area indicates where the drill guide is allowed to touch the bone (this too, can

be modified in 3D by the user). Clinical graphics are shown in figure 2.10 and 2.11

below.

Figure 2.17 : A cross section of the implanted models, shown with Hounsfield values, 3D

renderings and modeled mandibular nerve.
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(b)

(c) (d)
Figure 2.18 (a & b) : automatically proposed contact area, and contact area as modified by
the user.

Figure 2.18 (¢ & d) : automatically generated drill guide shape.

The main advantage of this system is that it provides for a safer dental implant surgery as the

facial area is known with having the most number of nerves. Any slight mistake could lead to

extreme complications and even fatalities.



2.6.4 Other Surgery Simulator Systems

i) Preoperative Stereolithographic Model Planning in Craniomaxillofacial Surgery, by
Christian Kermer; University of Vienna, Austria

ii) Artificial Knee Implants in Fluoroscopy Images Using A Model Fitting Technique,
by RD Komistek, SA Walker, EJ Northcut, WA Hoff, and DA Dennis; Rose
Musculoskeletal Research Laboratory, Colorado School of Mines

1i1) Femoral Anatomy, CT and CAD Design of Prosthetic Implants, by F Adam, DS
Hammer, D Pape and D Kohn; University of Saarland, Germany.

1v) Virtual Prototyping in Total Knee Arthroplasty, by BJ Fegly, G Sawyer and Rafi
Hatka; University of Florida.

V) Distributed Interactive Virtual Surgery System, by JXC Yonggao and H Wechsler;

George Mason University, Fairfax.

From the review of these existing systems, it has been found that all of them start with the
modeling process from CT or MR images, and proceed with the implant-insertion techniques

using image rendering software. CAD software apparently seems to be the most preferred

software in many systems.

For this thesis project, the The PISA Project on Dental Implant Surgery system has the most
similar criterions with what former system aims to achieve. The elaboration of the techniques

used has helped for a better understanding and would be the main guidance when

implementing the system design.
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2.7 Software Review
In order to develop this project, two platforms have been chosen which are the Raindrop

Geomagic Studio for the reverse engineering purpose and Rhinoceros 3.0 for implant fitting.

2.7.1 Raindrop Geomagic Studio
Geomagic claims to be the only complete solution for transforming physical parts into
manufacturable digital models. It automatically generates an accurate digital model from any
physical part. Geomagic Studio is also ideal for emerging applications such as mass production
of customized devices, build-to-order manufacturing, and automatic re-creation of legacy parts.
The advantages which this software delivers are such as:
e Guaranteed watertight polygon and NURBS models
e Ten-fold productivity increase over traditional CAD software when processing complex
or free-form shapes.
¢ Automated features and simplified workflow that reduce training time and allow users to
bypass tedious, labor-intensive tasks.
e Integration with all major 3D scanners and CAD/CAM software.

* Ability to work as a stand-alone application for rapid manufacturing or as a complement

to CAD software.
e Support of an extensive file input/output
eg: Native Scan Imports - 3PI, AC, ASC, BIN, SWL, CAM, CDM, etc.
Polygon Import/Export - 3DS, DXF, 1GS, LWO, NAS, OBJ, etc.

CAD Import/Export — IGES, STEP 203214, Neutral, VDA, Pro/E PRT, etc.
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e Large Data Handling

- triangulation and decimation methods can process models in excess of 100 million

triangles.

- multi-threaded operations for dual processors

- batch processing

Features in Geomagic which will be implemented in this project can be explained in Table

2.2 below:
Feature Description
Point Processing uniform, curvature, and ordered sampling
noise reduction with deviation display
hole filling
outlier and boundary selection
Polygon Creation and Repair wrap triangulation

curvature-based hole filling

partial hole filling and bridge creation
tolerance and shape-based decimation
fix intersections

make open/closed manifold

Polygon Editing

Boolean operations

shelling and offsetting

interactive relaxation/cleaning

smooth, fit, trim, project and extend boundary edges

F——— .
NURBS Surface Creation

one-click auto surfacing

automatic curvature detecting and editing

automatic patch construction

user-controlled surface layout

patch error detection and repair

automatic surface fitting

surface trimming with curves, features and other
surfaces

Analysis

point-to-point and on-surface distance

tolerance analysis (polygon/NURBS surface to
cloud)

curve analysis (curvature and tangency)

Table 2.2 : Features in Geomagic

56




2.7.2 Rhinoceros 3.0
Rhinoceros is one of the most powerful 3D modeling tools available on the market today. It has
been chosen as a platform to implement the implant fitting process as it is not supported by

Geomagic. The special features in Rhinoceros include:

Uninhibited free-form 3-D modeling tools like those found only in products costing 20 to

50 times more.

e Accuracy needed to design, prototype, engineer, analyze, and manufacture anything from
an airplane to jewelry.

e Compatibility with all other design, drafting, CAM, engineering, analysis, rendering,
animation, and illustration software.

e Read and repair extremely challenging IGES files.

e Accessible. It is easy to learn and use and user can focus on design and visualization

without being distracted by the software.

It is also easy to import and export data as it reads a large variety of file formats. Some data that
cannot be read in certain software are most likely to be readable in Rhinoceros. Therefore
Rhinoceros uses its export function to convert data from its current format which is readable by

the other intended software.
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Chapter 3

Methodology

Chapter Outline
This chapter explains the methodology that will be used in developing the system. It also
includes the system analysis section whereby the system’s functional and non-functional
requirements are listed, which are used as the foundation in designing the system later on. This

chapter shows how the system developer interprets the key features that should be implemented

in the real system.

67



3.0

3.1

Overview of Methodology

Methodology is defined as a collection of procedures, techniques, tools and
documentations. It helps software developers to build a system according to plan and
produce a high quality end product. There are a lot of methodology models currently in
existence. Ranging from the classic life cycle models to the innovative evolutionary

models, they provide adequate analysis on project duration, budget and requirements to

software developers.

The Prototyping Model

A system development model gives a standardized and systematic approach to the project
development. Software prototyping is an information system development methodology

based on building and using a model of the system for designing, implementing, testing

and installing the system.

The prototype modeling methodology has been chosen to aide in the development of this
project because of its many advantages. It has an iterative approach in modeling
processes whereupon each prototype developed in its respective stage is revised

continuously and flaws detected during revision period can be corrected along with the

development progress.
The characteristics of prototyping are:

* Prototyping is based on building a model of a system to be developed.

* Prototyping uses the model for designing the system.
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= Prototyping uses the model to implement the system.
* Prototyping uses the model to perform both the system and the acceptance testing
of the system.
Figure 3.1 below is a representation of the modeling processes that will be used in

developing this project.

System requirements

User review/

validation
Identifying prototype >
requirements < Revision
Revised prototype
; Userreview
Prototype design e Revision
Revised prototype

Revised and enhanced prototype

Prototype system

Revision
i
Fulfill users’
satisfaction No
Yes, verify
Test > Delivered system

Figure 3.1 : Prototyping Model Methodology
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In implementing the prototyping methodology in this system development, these

following steps are taken:

The system requirements are defined, which are gathered through various
discussions with the project supervisor and also by reviewing some existing
systems that are currently available.

A preliminary design will be created for the new system.

A first prototype of the system will be constructed from the preliminary design. It
is basically a scaled down system which represents an estimate of the
characteristics of the final system.

The first prototype has to be thoroughly evaluated, by noting its strengths and
weaknesses. Remarks on system performance will be collected and evaluated.
Based on the remarks, the first prototype will be modified, and followed by the
development of the second.

The second prototype will be analyzed in the same manner as the first one.
Preceding steps are iterations, which are finally concluded when the system has
fully functioned, satisfying system own requirements and the users’. Final

prototype represents the desired final product.
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3.1.1

Advantages of The Prototyping Model

Enhances understanding, because it is a partially developed product that enables
users and developers to examine some aspects of the proposed system and decide
if it is suitable or appropriate for the finished product.

Developers may build a system to implement a small portion of some key
requirements to ensure that they are consistent, feasible and practical. If not,
revisions are made at the requirements stage, rather than at the more costly testing
stage.

Example: Simulation of implant fitting may first focus on the degree of rotation
transformation axis that should be implemented to ensure that nail insertion is
done correctly and safely to prevent further damage at the fracture site.
Elongation of fracture may contribute to total breakage of the femur or traumatize
the femoral veins. As the correct transformation axis is achieved and satisfactory
to the user, the next step could be determining the depth of insertion.

Design prototyping helps developers assess alternative design strategies and
decide which is best for a particular project.

A prototype enables the users understand what the new system will be like, and
the designers get a better sense of how the users would like to interact with the
system. This is particularly important in developing a system in a biomedical
environment.

Example : The surgeons might not be technical-savvy enough to understand the
mechanics of the system. Thus a prototype will help them to adapt to the system,

and the process loops allow them to give suggestions and views.,
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= Developers get to measure the users’ level of understanding of the system.
Therefore, any disagreements and kinks in the requirements are addressed and
fixed well before the requirements are officially validated during system testing.

= Prototyping is useful for validating the implementation of all the requirements and

to verify that each function works correctly.

As a conclusion, it has been reviewed that in the prototyping model, requirements or
design need repeated investigation to ensure that both the developer and the user have a
common understanding of what is needed and what is proposed. Loops for the
prototyping requirements, design or the system may be eliminated depending on the goals

of the prototyping. This will definitely contribute to reducing risks and uncertainties in

the project development.
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3.2  Overview of System Analysis

Designing a system requires system analysis as the initial procedure before actually attempting to
design the system. This procedure consists of a few major steps which aide the development of
the system. Through analyzing current systems in the Literature Review section, problems are
spotted and defined which leads to generating the problem statement that has to be solved in this
system. Next, the determination of system requirements arises, which are collected by gathering
significant information. Requirements gathered lead to the development of alternative solutions

and finally choosing the most appropriate solution. Thus the primary deliverables from system

analysis are the listing of system requirements.
The main purpose of this phase can be concluded as listed below:

. To learn how a similar system functions.

) To resolve system requirements by collecting user needs and by identifying major

components to be included in the system.
- To ensure the software development methodology proposed is suitable for

analysing and developing the system.
. To determine hardware and software specifications to be used.

3.2.1 System Functional Requirements

Functional requirements describe an interaction between the system and its environment.
These are statements of services the system should provide, how it should react to
particular inputs and how the system should behave in particular situations. In some

cases, the functional requirements may also explicitly state what the system should not

do. Below are functional requirements for this project:
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Implant (scanned image data)

The point cloud image of the femoral component is needed for the resurfacing
module, before being able to be manipulated in the 3D modeling software,
Rhinoceros 3.0.

3D models

In developing the image rendering, animation and surgery simulation, the 3D
models of the human femur bone and the intramedullary nails are needed. These
elements will be acquired from earlier projects done previously. The 3D models
should be in computer graphics image types such as IGES, STL, 3DS, or any that
is compatible with Geomagic 4.5 and Rhinoceros 3.0.

Fracture location

Fracture location on the bone must be visible on the 3D model.

3.2.2 System Non-functional Requirements

Non-functional requirements describe the restrictions on the system that limits our choice

for constructing a solution to the problem. These include timing constraints, development

process constraints, standard and so forth.

Types of specimens

For the purpose of developing this project, only an adult human femur bone and a
femoral condylar metal implant will be used. Therefore, there will be no database
of these specimens, including the fracture types and solutions/outputs of the

simulated surgery.
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3.3

Reliability

To achieve the objective of providing this project as an extra tool in aiding
surgeries, it has to be of high reliability. This is because we are going to deal with
live patients in real-time surgeries and the simulation must be able to be delivered
correctly, or fatal post-surgery effects could arise.

Response time

There are two arguments regarding this issue. If the system is used as a leamning
tool for students, time might not be much of a deal. However, if a surgeon needs
to operate on a patient, the system must be able to deliver the correct simulation in

time with the event (system must not contribute to the delay of the surgery if the

surgeon is dependant upon it).

Consistency

No matter how frequent (or rare) the simulation system is run, it must be able to

produce outputs which are not only correct, but consistent all the time. This will

increase the reliability factor as well.

Software Requirements

Geomagic Studio Version 5.0

Rhinoceros Version 3.0

Windows XP Professional Edition and Windows 2000 Professional.
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3.4 Minimum Hardware Requirements

Intel Pentium 4 Processor
256 MB RAM
32 MB graphics card

SVGA monitor with 1280 x 1024 screen resolution

Mouse and keyboard
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Chapter 4

System Design

Chapter Outline

This chapter will discuss about the real design of the system which includes modules in the
processing engine to simulate the implant fitting surgery. Data flow diagrams explain the passage
of data from the input through the display of output. In this chapter, it generally explains how the

system will work in real-time and there is also a view of the chosen user interface.
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4.0  Overview of System Structure
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Figure 4.1 : System Design

The design of this system will be divided into three sections which are the input interface,

process (system engine) and the user output interface. The input interface for this system

contains two elements which are the 3D models of the femur and the scanned data of the implant.

The system engine is the most integral part of the system, where all the appropriate process will

be carried out here. It is where the techniques for simulating the surgery will be applied at.
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The third section is the output interface. Here, the simulation of implant fitting surgery will be

able to be reviewed. It will show how much change the implant will undergo.

4.1

Input User Interface

This research does not develop a typical system which involves input from a third party end user,

ie: a surgeon will not be using it to manipulate data of the surgery specimens. Those tasks will be

carried out by a technical person who will directly use the functions in the 3D modeling software

based on the guidelines from this documentation. Therefore, inputs will be the usage of

transformation tools and functions in modifying the structure of the femoral implant. Examples

of inputs can be described as follows:

Mirror the object display

This will provide the user with a copy of the object but in a symmetrical mirrored
position. It saves computation time as user will not have to dragging the object can be

exhaustive to the processor (because the size of the data is very big).

Bend parts of the object

User has to drag the mouse to point the direction of the bending movements of the
selected object.

Scale the size of the object

User has to input the amount of scale factor (to increase or decrease the size of the
selected object).

Move the position of the object

Moving the objects can be done by dragging (using mouse), or keying in the translation

and rotation values on the object’s X, Y or Z axis.
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42  System Engine

In order to run the simulation of the surgery, the system engine will need another two sub-
modules which are:

= Reverse Engineering for Resurfacing Purposes

To construct the surface of the femoral implant from the point cloud form to become a

polygonal object.
* Transformation
To modify the structure of the implant model so that it configures to the shape of the

femur condyle, thus reducing the possibilities of grafting the bone specimen in the actual

surgery. Processes include bending, scaling and rotating.

43  Output User Interface

Third party end-users such as surgeons will be able to see the new structure of the implant. They

can monitor the positioning of the implants and how much clearance exists between the implant

and the bone surface (the aim is to achieve the most minimal clearance value). Maximum

understanding of the surgery techniques can be achieved as the simulation can be analyzed using

the functions in Geomagic and Rhinoceros.
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4.4

Data Flow
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Figure 4.3 : Context Diagram
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Chapter 5

System Development and Implementation

Chapter Outline

This chapter discusses in detail the real implementation of simulation of implant fitting in
the femur bone. It explains the processes in the sub-modules which had been proposed in
carlier chapters; the reverse engineering process applied on the femoral component, and

how it is later exported to the 3D modelling module to be incorporated with the femur

bone model.
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5.1 Overview of System Implementation and Development.
The implant fitting simulation system has been developed based on two sub-modules as
below:

i) Reverse engineering

i) Transformation and fitting in 3D modelling environment
These modules are dependent on each other in ensuring the success of the project. The
first module is responsible for producing a virtual three-dimensional model of the metal

femoral implant component and the second as the platform to do all the necessary

transformations.

53  Reverse Engineering

Reverse engineering is the process where a scanned data of an implant is transformed into
a three-dimensional model. As shown in Figure 5.1, the implant image (acquired from
laser scanning process previously) was initially a point cloud data, and no further
manipulation can be done in this format. Thus, reverse engineering is needed to resurface
the image enabling it to be imported by 3D modelling platforms such as CAD and others.

The software Geomagic Studio Version 5.0 was used as the platform to carry out this

module.

84



Figure 5.1 : Femoral implant in point cloud form

The steps taken in this module are as follows:

i)

Cleaning up the outliers

Outliers are stray points that exist around the outside of the part. They are far
away from the main point cloud and do not represent any geometry that we
want to keep. This problem normally occurs when scanners inadvertently scan
objects in the background, such as tabletops, walls or support structure,

However, with this particular image no outliers were detected.
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iii)

Reducing Noise

Noisy elements are frequently introduced into a scanned data due to factors
such as small vibrations in the scanning device, inaccurate scanner calibration,
or poor preparation of the physical object’s surface. They can be identified by
a rough, uneven appearance in the surface model.

Geomagic uses statistical methods to determine where the points should lie

and moves them to this location. The range of optimize settings were set as

follows:
Shape : Free-form
Smoothness level s Medium

Freeform shape was chosen because the implant represents an organic shape
and the operation reduced the noise with respect to surface curvature.
Smoothness level was set to medium so that the data would not loose too

much of its accuracy (if set at maximum).

Results:

e Maximum distance 12.002696 mm
e Average distance : 2.510333 mm
e Standard deviation : 3.231173 mm

(from original positions of the points)

Uniform Sampling
This operation uniformly reduces the number of points in a point set. It

subdivides the model space into equally sized cubical cells and deletes all but
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one point from each cell. However, it still maintains the accurate
representation of the point cloud model.
Current spacing between points 0.2653 mm

Set to 0.52 mm

Figure 5.2 (a) : implant - before uniform sampling

87



Figure 5.2(b) : implant - after uniform sampling

Curvature sampling

Curvature sampling samples points based on their curvature and produces an
accurate wrap model with fewer points, thus contributing to a lesser
computation time. Points that lie in a high-curvature region remain in order to
maintain the accuracy of the surface curves. On the other hand, points on flat

regions are more likely to be deleted because they require less detail.

Current sample percentage 59.76

60

Set to
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Figure 5.3 : implant- after curvature sampling

(this figure shows that points on curved areas are more prominent after sampling is
done, compared to previous figures)

Sampling processes (iii and iv) can be considered as a trade-off between accuracy and
space. The data might not be 100 percent accurate anymore, but it will take up lesser
memory space. This will increase the processing speed when the model is used in

another application..
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V) Surface Wrapping

The wrap operation is done to construct a polygonal surface.

Figure 5.4 : Implant - surface wrapped polygonal model

Results:
Current points : 27 974

Current triangles : 55 923

vi)  Filling up the holes

The Fill Holes tool was used to fill in regions of missing data.

Results:

Current points : 27 661
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vii)

viii)

Current triangles : 55 318

After holes are filled up, the number of points decrease whereas the number of
triangles in the model have increased.

Changing Manifold Surface

Manifold objects are objects in which all the triangles are connected
continuously by their edges. For this step, the implant model will turned into
an open manifold object since it is not volume bound. Therefore, it will be an
open surface model.

Creating a NURBS surface

To create the NURBS surface, its function in Geomagic was “set to
automatically estimate the complexity of the model geometry. The Surface
Detail function was set to maximum so that calculations will also be
performed on smaller portions of the surface, resulting in greater detail. The

result can be seen in Figure 5.5 as below:

Figure 55: Surfaced implant model
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Relaxing the surface
The relax operation smoothens the surface of the polygon model by changing
the input vertices.

[teration: 20

Strength: 0.5
The iteration was set at the recommended amount while the strength was at
medium, on a scale of 0.0 (minimum) to 1.0 (maximum). This was to obtain a

fairly smooth surface but not compromising the accuracy of the original data.

Constructing Patches

Patches need to be constructed on the surface of the model for us to create
curves in later step. This function was also set on automatic. Contours were

simplified as to obtain perfect shuffle patches.

Results:
Patches: 1476

Current triangles: 200 000
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Figure 5.6 : Patched implant model

Creating curve object

Curves are created because it is a very important feature in the fitting module.
These curves will be transformed (bent, scaled, etc) on the Rhinoceros

platform for the implant to be fitted on the bone specimen.

From this function, 1324 curves have been obtained.
Minimum boundary length: 1.656803 mm
Maximum boundary length: 3579.44070 mm

Average boundary length: 1709.675609 mm

Number of self-intersecting paths ; 120
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xii)  Analyzing the curve model

The curve model can be analyzed in Geomagic to get important statistics that
may be applied in other applications if needed.

Results:

Radius: (in mm)
Minimum: 0.0004164346
Average: 24.01663
Maximum: 11102.62
Standard deviation: 88.68865

Curvature: (in mm)
Minimum: 9.006884e-005
Average: 0.3243133
Maximum: 2401.338

Standard deviation: 7.084274
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5.3 Transformation and Fitting

After being resurfaced in the previous module, the metal femoral implant component can
now be exported from Geomagic to the Rhinoceros platform. The main objective of the
transformation module is to achieve fitting of the implant to the femur condyle as shown

below:

front

Figure 5.7: How implant is fitted to the femur condyle

With reference to Figure 5.7, this is actually an x-ray image of a Caucasian patient who

has undergone a knee arthroplasty surgery. However, Asians have differing shape of the

femur condyle. The front part of an Asian femur condyle is slightly curvier, thus becomes

an obstacle to achieve a good fitting a European made implant. The femur bone specimen

S0y i thic nraiact 1S § in figure 5.8.
from an Asian patient which is used in this project is shown in fig
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The steps taken in this module are as follows:

i)

Figure 5.8: Femur bone model to be used in the project

Alignment of models

The bone and implant models are both used in curve format. This is to ensure
that correct transformations can be achieved. Although surface models
promote speedier computations, they can be badly distorted when we attempt

to modify the shape of the implant object.
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ii)

To facilitate upcoming steps, both the bone and implant models are aligned
together using the different viewports in Rhinoceros. It is best to give priority
to the side views as it will be easier for us to compare the curved part of the
bone with the implant structure. This is because the curved front part is the

most important feature to be considered.

Figure 5.9: Aligning implant to the bone through the right viewport

Comparing the structures of both models with each other
Before proceeding with the transformations, the models were overlapped and

compared with each other to get a rough view of how much resizing should be

done to the implant.
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As shown in Figure 5.10, the implant is smaller compared to the bone.
Therefore, it can be concluded that it has to be enlarged so that the inner
surface can conform to the curvature of the condyle. However, some parts of

the implant can be seen protruding out of the bone structure (Figure 5.11)

because the latter is not a symmetrical object.

iii) Scaling the implant

The difference between the horizontal dimension of the inner surface of the

implant and the outer structure of the condyle are measured.
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Figure 5,12 : Measuring the horizontal dimensions
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Horizontal dimension (in mm):

Implant: 43.13
Bone: 64.20

From these measurements, we are able to obtain the scaling factor from a

simple calculation.

( Bone — Implant ) x 100= percentage of difference

Implant

(6420 -43.13)x 100 = 48.85
43.13

Therefore, the scale factor is 1.48.

iv) Bend Transformation

After being scaled, the part of the implant to be fitted with the front part of the
condyle was bent to conform to the shape of the condyle. Although bending
can be done, it may lead to imperfect fittings at other parts. This problem has
been predicted and it is still acceptable since the clearance between the two
objects will help us determine the healing progress after the surgery. A large
clearance value will slow down healing, while a small value will ensure faster
healing time. The clearance value can be measured by using vertical

dimension function. From figure 5.13, it is shown that the clearance value

between the two objects is 4,68 mm.
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Figure 5.13: Clearance dimension value

v) Test the fitting again in Geomagic
The fitting done in Rhinoceros can tested again using the Geomagic platform.
The improvised implant model was imported in Geomagic and fitted to the
bone model using the Best Fit Alignment function, Three points were marked
on each model for them to be fitted accordingly. The result is shown in Figure

5.14.
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Figure 5.14 : Fitting of models using Best Fit function in Geomagic

It can be seen clearly that both objects do nof accurately fit each other. Therefore, we

can conclude that for the patient has to allow some time for the bone to grow back in

time for it to be fully healed.
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Chapter 6

System Experiment and Testing

Chapter Outline

This chapter explains the experiments which have been tried out in manipulating the
femoral implant. There will be discussions on the successful and failed steps and the
justifications on the functions that have been used.
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In developing this project of simulating the fitting of an implant to its complimenting
bone structure, a lot of experiments and trial-and-error sessions were carried out. We
need to find out the most useful transformation functions in the 3D modelling software
which can almost offer the desired fitting in the least amount of time. This is because the
parties involved, surgeons and patients alike, require immediate arthroplasty procedure to
minimize the risk of pain and infection on the injured anatomy.

The experiments were done using the implant model in two formats, curve and surface.
It has been found that using the curve model is a better option than with the surface
model. However, one major limitation that would most likely occur is it decreases the
computation speed to a very low level. The possible cause for this problem to arise is the
presence of the femur bone model which takes up a large portion of the memory because
of its huge size. Therefore, maybe only the distal portion should be cut out to be used in

this type of process (in future works).

6.1  Testing the fitting using surface model

The surface model is a polygon mesh generated on its NURBS surface. The use of a
surface model allow the computation to be a little bit speedier, therefore allowing results
to be shown in less time. However, not all transformations can take advantage of the
surface model. The result of testing the implant fitting can be best shown by the bend
transformation. If all of the surface patches are selected, the implant seemed to have
twisted when bent. If only a few patches are selected together, the bending will break

them from other surfaces as shown in Figure 6.1 below.
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Figure 6.1 : Patches ‘break’ apart from others when only a few are bent
When exported to Geomagic for surface reconstruction, the separated patches will still

leave gaps that cannot be patched again. These gaps will have edges that are considered

as the boundaries.
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Figure 6.2: A failed attempt to reconstruct the implant surface

6.2  Testing the fitting using curve model

By using the curve model, specific parts of the implant model can be selected and
transformed manually (by switching on the control points) or by using the functions
available in Rhinoceros. As a curvier shape needs to be obtained, this front part of the
implant needs to be slowly adjusted to get a similar structure as the femur condyle, The
result was very satisfying where the curves can be selected as needed, and only those

curves will transform their structure according to the modifications applied by the user,

106



The curves will also not break away from the original structure contributing to a less

exhaustive approach to the whole process.

Figure 6.3 : Bend transformation using a curve model

A helpful transformation that can be used would be the mirror function. Less dragging or

rotating movements can be made if we need to adjust the direction of one object to match

another.
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Figure 6.5 : Rotating an object
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Both the curve and surface models have been used in the scaling transformation test. This
type of transformation can be useful to resize the size of any 3D model, either in the
three-dimensional format or according to an axis (x, y or z). However, there is a
drawback in using this function. Since it resizes the model uniformly, the result showed
that the thickness of the implant will also be compromised. A wrong scale value might
enlarge or reduce the thickness too much producing an undesirable structure of the
physical implant. And not only that, the output will also affect the weight of the actual
implant if it is to be manufactured according to the scaled result. Thus, careful calculation
has to be done to ensure the end result will contribute to a feasible and manufacturable
product.

It is hoped that by using these test results as a guideline, the actual implementation of

manufacturing a custom-sized implants for Asians can be carried out accordingly.
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Chapter 7

Conclusion

Chapter Outline
Chapter 7 concludes and evaluates the thesis in various aspects such as its advantages,

disadvantages and also discusses issues that relate to the project. This chapter also

suggests ideas towards the enhancement of current implant fitting system.
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7.1

iii)

vi)

Advantages of The System

The success of such as this particular system will offer custom-made implants
to the Asian population. While manufacturing one specific implant for each
patient might not be cost-effective and impractical, researchers can do a study
on the size of the population’s knee structure and come up with common sizes
among the people. Then the implant can be modified according to these
average sizes to be used by patients.

Patients with deformities may also benefit from this system because the
femoral implant can be modelled based on the shape of his/her bone structure.
Patients will be able to experience a more rapid healing time since the implant
fit almost accurately to the bone. This allows the need for lesser bone re-
growth to heal the wound (for both parts to fully fit together).

Surgeons benefit by spending lesser time in the operation theatre. They do not
have to re-insert the bone over and over or cutting its surface to fit it into the
curvature of the implant.

Implants might be able to be produced locally or at least in the Asian region,
thus cutting the cost of medical bills.

The use of the selected software, Geomagic and Rhinoceros, is such an
excellent feature because these platforms can back each other up in the event
of one not being able to support certain type of data formats. They each have
analysis features which may be used at the same time and compare the results

with each other.
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7.2

i)

iii)

7.3

Limitations of The System

The fitting is not exactly 100% accurate. This is because a human anatomy is
never symmetrical in shape; therefore the femur too is not. Some parts of the
implant may configure to the femur structure, and some may not. The
clearance value between the femur and implant surface will determine the
how long patients take to recover from the procedure.

Attempts to bend and transform the model may be exhaustive because of the
complex nature of the femur.

The capability of the software can be limited when it comes to certain
functions. For example, attempts to blend the two surfaces were not successful
because the software could not recognize the edges of the objects. This could

be due to the fact that the objects in use are organic instead of geometrical

(man-made) in shape.

Related Issues

There is a need for faster computation. The data used in this project consists
of enormous of enormous sized 3D models, such as the femur bone model and
the NURB model of the implant. Therefore, a normal home-use (or even
office-use) computer will not be able to handle such large data to process.
Reducing the size of the data is definitely not an option because it will deter
the accuracy,

The hardware limitation means that we need to use a high-performance

graphics card. Another ideal solution might be to use a workstation such as an
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SGI machine or a Sun Workstation. If we opt to use Windows solution on a

Pentium 4 platform, simultaneous multi-processors would be a better option.
iii)  Although the manufacturer of Rhinoceros claims its software can used on any

type of computer, even a laptop, the large data size has made the system non-

portable as we would like it to be.

7.4 Suggestion for Future Works

The finished result of this project may not actually be able to be implemented
immediately. This is because we need to test if the modified implant can withstand tlIIe
constraints of a patient’s weight and his movements in daily activities. A possible task is
to do a research on finite element analysis (FEA) on the model. Next, we may proceed to
thorough improvisation of the structure of the implant model from the analysis result

before finally manufacturing the end product.

113



Appendix

(i)

(ii)

(iii)

(iv)

)

(vi)

trochanter

One of two processes near the head of the femur, the outer being called the

great trochanter, and the inner the small trochanter.
eminence
A projection or protuberance from the surface of a body part, especially a

bone.

condyles

A rounded articular surface at the extremity of a bone.

articular

Of or pertaining to a joint.

comminution

A fracture in which the bone is broken into pieces

vascularized

Rendered vascular by the formation of new vessels.
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(vii)

(viii)

(ix)

(x)

(xi)

(xii)

supracondylar

Above a condyle

varus
An abnormal position in which part of a limb is twisted inward toward the

midline, opposite of valgus.
valgus
An abnormal position in which part of a limb is twisted inward toward the

midline, opposite of varus

osteoporotic

Pertaining to, characterised by, or causing a porous condition of the bones

diaphysis

The shaft of a long bone.

Paget Disease

Disease of unknown aetiology involving destruction and reparation
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(xiii)

(xiv)

(xv)

(xvi)

(xvii)

percutaneous

Performed through the skin, as injection of radiopacque material in
radiological examination or the removal of tissue for biopsy accomplished by
a needle.

ligamentous

Relating to or of the form or structure of a ligament.

osteopenia
Decreased calcification or density of bone; a descriptive term applicable to all

skeletal systems in which such a condition is noted; carries no implication

about causality.

trabeculae

Muscular bundles on the lining walls of the ventricles
malunion

Union of the ends of a broken bone resulting in a deformity or a crooked limb;

frequently used interchangeably with faulty union.
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This research has been carried out using five data. Please find these files in the CD-ROM

included:
e partl.asc
e bonel .stl (surface model)
e bone2 stl (surface model)
e bonel.igs (curve model)

e bone2.igs (curve model)

A. Reverse Engineering
Phase 1 : The Point Phase
To create the surface of the implant, use Geomagic Studio 5.0.

Open the file “part].asc”. This is the implant data in point cloud form.

Figure 1 : Point cloud model of the implant
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i) Clean up the outliers

Outliers are stray points that exist around the outside of the part. They
are far away from the main point cloud and do not represent any
geometry that we want to keep.

From the “Edit -> Select” menu, choose “Disconnected
Components”. Change the “Separation” dropdown menu to Low,
and leave the Size value at 5%. The software will select any clusters
of points with 5% or less of the total number of points. If these points
are seen on your display, select them and delete by clicking the “X”

button on the toolbar, or click “Erase” from the “Edit” menu.

ii) Reducing Noise

Noisy elements are frequently introduced into a scanned data due to
factors such as small vibrations in the scanning device, inaccurate
scanner calibration, or poor preparation of the physical object’s
surface. They can be identified by a rough, uneven appearance in the
surface model.

Use the “Reduce Noise” function in the “Points” menu.

User will be prompted to choose the shape of the model and the
desired smoothness level. Select “Freeform” shape if the model
represents an organic shape, or “Prismatic” if it is a geometrical
model with sharp edges and small details to preserve,

The operation reduces the noise with respect to surface curvature.
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e The Average Distance and Standard Deviation values are reported

under Statistics.

iii)  Uniform Sampling

e This operation uniformly reduces the number of points in a point set. It
subdivides the model space into equally sized cubical cells and deletes
all but one point from each cell. However, it still maintains the
accurate representation of the point cloud model.

e From the “Points”menu, click on “Uniform Sample”.

e There will be a display of the current spacing between the points. We
may change and set this value (manually or by using the dial) to
reduce the size of the data.

iv) Curvature sampling

e Curvature sampling samples points based on their curvature and
produces an accurate wrap model with fewer points, thus contributing
to a lesser computation time. Points that lie in a high-curvature region
remain in order to maintain the accuracy of the surface curves. On the
other hand, points on flat regions are more likely to be deleted because
they require less detail.

e From the “Points”menu, click on “Curvature Sample”.

e The current sampling percentage is displayed. Change its value to
user’s desire. However, the accuracy on flat areas might be reduced if

the value is set too high.



V) Surface Wrapping

e The wrap operation is done to construct a polygonal surface.
¢ From the “Points” menu, select “Wrap”.
e You will have to choose either “Surface Wrap” or “Volume Wrap”.

e When the wrapping is done, the model will transform from point to a
polygon. Notice that Geomagic will have also transformed to the

Polygon Phase Environment.

Phase 2 : The Polygon Phase
i) Filling up the holes

e The Fill Holes tool is used to fill in regions of missing data.

Toggle on the Holes checkbox in the Primitives Panel. This highlights in

green any hole or open edge on the model.
e From the “Polygons” menu, click “Fill Holes”.

e Click on the Fill All button. This will automatically fill all the holes on the

model.

e Holes can also be filled one by one. Just click on the highlighted edges of

each hole and it will be filled instantly.

e However, curvature-based filling might not be recommended for certain
holes. Therefore, the software will suggest to the user to use flat-filling

instead.
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e After holes are filled up, the number of points decreased whereas the

number of triangles in the model increased.

ii) Changing Manifold Surface
e Manifold objects are objects in which all the triangles are connected
continuously by their edges. For this step, the implant model will
turned into an open manifold object since it is not volume bound.
Therefore, it will be an open surface model.
e From the “Polygon” menu, click “Make Manifold” then choose

“Open”.

Phase 3 : The Shape Phase

To construct a NURBS surface out of the model, we must transition to Shape Phase.
Click the Shape Phase Icon 8 . When in Shape Phase, the menus in the menu bar

change to include headings for Patches, Grids, and NURBS,
i) Creating a NURBS surface

e Click NURBS > AutoSurface in the menu bar, or click the icon. A
dialog appears.

e Check the Auto Estimate box for Studio to analyze the model and
determine the level of simplicity or complexity and generate curves
and patch layout accordingly.

e Move the slider bar to gauge the complexity of the model geometry.
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e Move the Surface Detail slider toward a minimum or maximum
preference. This slider affects the level of detail of the NURBS
surface. Click Apply.

e Towards the maximum position, the operation will perform
calculations on smaller portions of the surface, resulting in greater
detail.

e Towards the minimum position, the operation will perform

calculations on larger and fewer portions of the surface.

This model can now be saved in the IGS format. Close the file and re-open it again. You
will see that the implant model will now be in the CAD Phase environment. From this
stage, we need to move to constructing patches. This feature is only available in the
Shape Phase. Therefore, Click CAD > To Polygons in the menu bar. Then click on the

Shape Phase icon once again.

ii) Constructing Patches
Patches need to be constructed on the surface of the model for us to create

curves in later step.

e Click Patches > Construct Patches in the menu bar. The Construct

Patches dialog box opens in the Dialog Manager.
e Select desired option:
e  Optimize Vertex Degree optimizes path structures.

e Simplify Curves creates perfect shuffle patches.
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e  Auto estimate will automatically apply the number of
patches suitable for the model.
e If Optimize Vertex Degree or Simplify Curves is selected, enter the
desired value in the Target Patch Count text box.

e Click Apply to preview the patch structure.

Figure 2 : Example of Patched implant model

o The implant model could also be saved as a surface model after we

create the surface patches.

iii)  Creating curve object
Curves are created because it is a very important feature in the fitting module.

These curves will be transformed (bent, scaled, ete) on the Rhinoceros
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iv)

platform for the implant to be fitted on the bone specimen. The Create Curve

Object operation creates a curve model based on the (designated) curves of a

model. This operation exists in both Point and Polygon Phase. Therefore, we

must transition again to Polygon Phase (by clicking on the Polygon Phase icon

—
prsm———

Choose the “Convert to Curve Model” radio button to enable
the transition.

Click Curves > Create Curve Object in the menu bar. The
Create Curve Object dialog box opens in the Dialog

Manager.

Select the desired control point layout from the Control Point

Layout text box.

If you select the Adaptive option, enter a value in the

Maximum Control Points and Control Points Spacing text

boxes.

If you select the Tolerance-based option, enter a value in the

Error Tolerance text box.

If you select the Constant option, enter a value in the Control

Points text box.
Enter a value in the Tension text box.

Click OK to accept the new curve model.

Analyzing the curve model
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The curve model can be analyzed in Geomagic to get important statistics that

may be applied in other applications if needed.
e Click Analysis > Analyze Curves in the menu bar.

e The Analyze Curves dialog box opens in the Dialog Manager and the

statistics are displayed.

Phase 4 : Transformation and Fitting

After being resurfaced in the previous module, the metal femoral implant component can
now be exported from Geomagic to the Rhinoceros platform. The main objective of the

transformation module is to achieve fitting of the implant to the femur condyle.

The steps taken in this module are as follows:

i) Opening and Importing Images
e Open the file bonel.igs.

e When it is displayed in the view ports, go to File > Import and select the

file bone2.igs. It will automatically merge with bonel.igs to construct a

complete femur bone structure.
e Next, import the implant model (in curve format).

e We can also use the surface models (bone_1st_half.stl, bone_1st_half.stl
and implant model in surface form,). However, ALL models must be in

the same format (all curve models, or all surface models).
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Alignment of models

Both the bone and implant models are aligned together using the different
view ports in Rhinoceros. It is best to give priority to the side views as it will
be easier for us to compare the curved part of the bone with the implant

structure. This is because the curved front part is the most important feature to

be considered.

e Click View > Zoom > Extents All to get the centralized view of the
objects in all view ports.

e Use the Right-Click mouse button to move the planes.

e Use the Left-Click mouse button to select objects.

e If the curves/surfaces are considered as single object each, we can group

them together to simplify and facilitate our work. Select all the

surfaces/curves, then click the Group icon E/

|

. You can ungroup by

clicking
e Select object and left-click to drag it vertically or horizontally. Freeform

drag can be done by simultaneously pressing the shift button and left-click

mouse.

Object Transformation
a) Bend

e Select the objects,

e At the Start of spine prompt, choose the first endpoint of a

line representing the original orientation of the object.
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To bend the entire object, place the point outside the object.
At the End of spine prompt, choose the second endpoint of
the line.

At the Point to bend through (Copy=Yes
StraightEnd=No ) prompt, ch(_)ose the amount of bend.

The bend only applies to the points of objects that are
inside of that axis. If you make an axis that is smaller than
an object, you will only bend that part of the object.

Bend moves the control points of objects. You have to
construct your object with a lot of control points so that it

will bend properly.

Note : You can't bend a polysurface, only control points,

curves, surfaces, and meshes.

b) Flow objects along curves

This function is useful to bend an object to configure it to
the curve of another object, thus simplify fitting.

Select the objects.

At the Original backbone curve - select near end
( Copy=No Line ) prompt, select the "backbone" curve of
objects to flow.

You might want a line to be one of the backbones. Instead

of drawing a line before the command, type L and press

Enter to draw the reference line.
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At the New backbone curve - select near end ( Copy=No

Line ) prompt, select the new backbone curve to flow to.

This curve will be used as a new backbone. The objects are

twisted from the first backbone's shape into the second

backbone's shape.

¢) Mirror

If the objects are placed in different directions to each

other, we can transform it to the opposite direction by using

the Mirror function.

Select object.

Then choose Mirror from the Transform menu.

At the Start of mirror plane ( Copy=Yes ) prompt, choose a
point on the mirror plane.

At the End of mirror plane ( Copy=Yes ) prompt, choose a
second point to define the mirror plane. As you move the
cursor, Rhino previews the location for the mirrored
objects. The two points specify a mirror plane

perpendicular to the construction plane.

Scaling the implant

The difference between the horizontal dimension of the inner surface of the

implant and the outer structure of the condyle can be measured after both

objects are aligned together.
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Figure 3 : Measuring the horizontal dimensions

Example : Horizontal dimension (in mm):
Implant: 43.13

Bone: 64.20

From these measurements, we are able to obtain the scaling factor from a

simple calculation.

Bone — Im x 100= percentage of difference

Implant
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(6420-43.13)x100 = 48.85

43.13

Therefore, the scale factor is 1.48.
The clearance value can be measured by using vertical dimension function. From the

example below, it is shown that the clearance value between the two objects is 4.68
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Figure 4 : Clearance dimension value
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Test the fitting again in Geomagic
The fitting done in Rhinoceros can tested again using the Geomagic platform.

The improvised implant model can be imported in Geomagic and fitted to the
bone model using the Best Fit Alignment function.

Note that the bone model files cannot be read in Geomagic. Therefore we
must export it to a format that is compatible with Geomagic using

Rhinoceros.

e Choose the bone model, and click Export Selected from the File

menu.

e Give anew name to the file and save it as 3DStudio (.*3ds).
e We may now open the file in Geomagic.

The fitting process is as follows:

° The easiest method is to use the Align Objects tool. It aligns a
model to another model based on three selection points. This tool
is especially useful if you are applying a template to a model. The
three points serve as reference points and make it easy to0 match
models up with each other.

B Click Tools > Align > To Object in the menu bar. The Align
Objects dialog box opens in the Dialog Manager.

B Check the Enable check box in the Active Object option box and
select three points on the model.

B Check the Enable check box in the Target Object option box and

select the same three points on the Target Object.

135



. Click OK to align the The result is shown as in the example below.

Figure 5 : Fitting of models using Best Fit function in Geomagic
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5.3 Transformation and Fitting

After being resurfaced in the previous module, the metal femoral implant component can
now be exported from Geomagic to the Rhinoceros platform. The main objective of the

transformation module is to achieve fitting of the implant to the femur condyle as shown

below:

front

Figure 5.7: How implant is fitted to the femur condyle
With reference to Figure 5.7, this is actually an x-ray image of a Caucasian patient who
has undergone a knee arthroplasty surgery. However, Asians have differing shape of the
femur condyle. The front part of an Asian femur condyle is slightly curvier, thus becomes
an obstacle to achieve a good fitting a European made implant. The femur bone specimen

from an Asian patient which is used in this project is shown in figure 5.8.
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